Getting Started with TranSight

Version 3.3
# Table of Contents

Table of Contents ........................................................................................................................................ 2
Welcome ....................................................................................................................................................... 3
  What Is REMI TranSight? .......................................................................................................................... 3
System Requirements ................................................................................................................................... 4
Installation .................................................................................................................................................... 5
Starting TranSight .......................................................................................................................................... 6
Modeling a Transportation Scenario ........................................................................................................ 8
  Travel Demand Study ................................................................................................................................ 8
    Importing Data ....................................................................................................................................... 9
    Travel Editor .......................................................................................................................................... 10
  Baseline and Adjusted Simulations and Computed Difference ............................................................... 11
  Computed Difference ................................................................................................................................ 13
  Region-to-Region Spread .......................................................................................................................... 13
  Simulation Parameters ............................................................................................................................. 15
  The Add To Inputs List Button .................................................................................................................. 20
Cost Matrices ................................................................................................................................................ 22
  Additional Highway Inputs ....................................................................................................................... 24
Modeling an Economic Scenario .............................................................................................................. 33
Other Features and Usage Tips ................................................................................................................ 40
  Cumulating Policy Variables and Understanding Results ..................................................................... 40
    Selecting and Activating Variables ........................................................................................................ 40
    Using Analytical Graphs to Understand Results .................................................................................. 45
  Moving the Tables to a Spreadsheet ....................................................................................................... 53
Getting Additional Help .......................................................................................................................... 55
  Contacting REMI Technical Support ...................................................................................................... 55
REMI’s Web Site ........................................................................................................................................ 55
Welcome

Welcome to REMI TranSight. Your program package includes both regional and national data models. The regional data and model have been calibrated to the region(s) that you specify at purchase, and all packages include a Windows® point-and-click interface that makes operating the program easy for all levels of computer users.

What Is REMI TranSight?

TranSight is the leading tool for evaluating the total economic effects of changes to transportation systems. Grounded in over 20 years of transportation modeling experience, TranSight provides an integrated system for comprehensive evaluation of transportation systems. This approach allows analysts to thoroughly describe the far-reaching economic and operational effects of transportation projects. As with PI®, TranSight is used by government agencies, consulting firms, and universities.

Integrating economics with travel demand modeling, TranSight dynamically demonstrates how transportation makes economies competitive. Users can test alternative transportation changes and observe the short and long-term impact on jobs, income, population, and other economic variables. TranSight is a sophisticated modeling tool that integrates travel demand models with the REMI model and is constructed with extensive data on emissions, safety valuation factors, and other data.

In addition to continuously improving the software and pushing the frontier of regional economic modeling, REMI is dedicated to providing quality customer service and support.
**System Requirements**

We recommend that your computer system meet the following specifications. TranSight may run on systems below these minimum specs, but functioning is severely impaired.

For standard models:

- Windows 2000, XP, Vista (32- or 64-bit) or Windows 7 (32- or 64-bit)
- 1.4 GHz or faster processor
- 1 GB RAM (2GB for Vista/7)
- 1024x768 display
- 2 GB of available hard-disk space

For large models with 50 or more regions:

- Windows XP, Windows Vista (64-bit) or Windows 7 (64-bit)
  (Windows XP requires a special boot parameter to increase addressable memory. 32-bit versions of Vista and 7 are not supported.)
- 3 GB RAM for XP, 4 GB for Vista/7
- 2 GHz or faster processor
- 1024x768 display
- 10 GB of available disk space

Simulation execution time increases exponentially with the number of regions and industry sectors. Large models (i.e. >12 regions) benefit greatly from increased memory capacity and processor speed. For example, on a computer with a 3 GHz Intel Core 2 Duo processor and 3 GB of RAM, a 3 region model will run a 25 year forecast in 6 seconds, while a 51-area model takes 14 minutes.
Installation

IMPORTANT NOTE: You must have Windows administrative privileges to install this software.

When you are ready to install REMI TranSight, insert the provided CD into your CD-ROM drive. The InstallShield installation utility should run automatically. If it does not appear, select your CD drive in “My Computer” (XP) or “Computer” (Vista/7) and double-click “setup” or “setup.exe” to start the installation process. A shortcut to the application will appear on the desktop once the installation is complete.

Contact REMI or your system administrator if you need assistance with installation or operation of the software.
Starting TranSight

To start TranSight, double click on the shortcut appearing on your desktop.

Now you will be viewing the Home tab. Note the default name of the workbook located on the header when you first open TranSight is Untitled.rwb. You will have the opportunity to rename this document when you save a new forecast. The name of the specific model is located on the status bar at the bottom of the window. The ribbon below the Home tab displays three groups: Add a Forecast, Views, and About. The Workbook view is the default, and contains the Standard National Control and Standard Regional Control. The Inputs view is empty until running additional forecasts, and the Results view gives you the option of displaying the history and forecast of any controls or simulations stored in the workbook. The About group provides access to Model Details such as the national input output table and also displays a direct link to the REMI website where additional information and documentation may be found.
To start a new simulation, click on the Regional Simulation button. The Insert tab now appears.

The Insert tab displays three groups in the ribbon: Transportation, General, and Tools. The Transportation group organizes access to transportation-related policy variables, specifically Effective Distance, Multi-Modal, and Highways. The General group organizes economic and demographic-related policy variables into five sub-groups, with the most structured approach available on the Blueprints button, a more moderately structured approach in the Scenario button, and the least structured approaches in the Topics, Model Blocks, and Full List buttons. Tools are available to assist with filling in values for previously selected policy variables (Calculator and Spreader) and Importing/Exporting policy variables to or from other applications.
Modeling a Transportation Scenario

In order to model a Transportation Scenario originating from an exogenous travel demand model (or files created with TranSight’s Travel Editor), click on the Highways button and then on the menu that opens up, choose Travel Demand. The Travel Demand Study dialogue will appear, displaying the available inputs.

**Travel Demand Study**

The Travel Demand Study imports and converts the data from travel-demand models (or from the files you created with the Travel Editor) for use in TranSight. You can view Baseline and Adjusted Simulation data; the Baseline Simulation is the “no-build” scenario forecasting what will happen without the proposed changes, and the Adjusted Simulation is the “build” scenario forecasting what will happen if the changes occur. You can also view the Computed Difference between the Adjusted Simulation and the Baseline Simulation and choose to View or Edit the Advanced Parameters used by the Travel Demand Study.
Importing Data

TranSight links travel-demand models to REMI’s economic model engine. Importing travel-demand model information is easy, because TranSight automatically converts all the data into policy variables.

The first step is to select your travel-demand model in the drop-down box.

![Model Type: TS Travel Editor - Annual, with year series]

If you want to use data files that you created in the Travel Editor, choose **TS Travel Editor**. Note: You can only choose TS Travel Editor if you have already used the Travel Editor to create data files for a baseline and an adjusted simulation. Next, we need to make sure that TranSight is using the correct data set from your travel-demand model. Look at the file paths in the Adjusted and Baseline simulations. They should look something like this:

**Baseline Travel Demand Data:**

![Baseline Travel Demand Data]

If this is the correct file path, you don’t need to do anything. If it’s not, you’ll need to find the folder containing the desired data set. Here’s how:

1. Click the button at the right of the file path box to open the Browse for Folder window.

2. Navigate to the folder containing your simulation data.

3. Select it and click the button. TranSight converts the data.
Travel Editor

If you do not have access to a travel-demand model, use the Travel Editor utility to manually create input files with information on VMTs, VHTs, and trips. The Travel Editor allows you to input your own data from spreadsheets, or modify an existing data file, to use instead of travel-demand model data in the simulation. Once you create your files, choose **TS Travel Editor** in the Model Type drop-down menu for your data to be input into TranSight.

Perform the following steps for both your baseline and adjusted simulation(s):

1. Enter the full path and name of the data file you wish to modify on the Data File tab, or use the **Browse** button ( ...) to select one from the simulation folder you want to use.
2. If you would like to modify previously existing Travel Data File rather than starting a new one, click on **Load** on the Data File tab.
3. Select the **Road** tab or the **Transit** tab.
4. Paste or type in the miles, hours, and trips for each region-to-region combination, time period, and mode. You are entering the miles, hours, and trips per year for each year of the simulation; the origin region in each table is the row and the year is the column, and the “To Region” combo box near the top of the window is used to select a destination region.
5. Repeat step 2 in both the Road and Transit tabs if you have data for both roads and public transit.
6. Make sure the filename and folder where you want to save the data are displayed under File Name on the Data File Tab. To change folders, click on the button to open the file browser.

7. Click the button on the Data File Tab. Your data is now saved to the chosen file.

8. Close the Travel Editor window.

9. Choose TS Travel Editor from the Model Type drop-down menu on the Travel Data Tab. The TranSight simulation proceeds as usual with the data you entered.

If you wish to modify an existing travel-data file, make sure the name and folder of the file are displayed under File Name on the Data File Tab of the Travel Editor window, and click the Load button. Make the changes you want, and Save again.

**Baseline and Adjusted Simulations and Computed Difference**

TranSight takes the data for the Baseline and Adjusted Simulations directly from your travel-demand model. The Baseline data should normally come from a travel-demand model simulation that includes no transportation projects, or otherwise represents a reference case against which comparisons are made to alternative scenarios. The Adjusted data should normally come from a travel-demand model simulation that incorporates one or more upgrades to the transportation network. The Computed Difference is the calculated difference in VMT, VHT, and VTT between the Adjusted Simulation and the Baseline Simulation.

You can view this information from the Travel Demand Study window. To make any changes to the data, you must do so in your travel-demand model before importing it into TranSight. Here’s how to view the data:

1. Click the button next to the heading Calculated Travel Totals for the concept you wish to view, Adjusted, Baseline or the Difference between the two.

   **Calculated Travel Totals:** Baseline  Adjusted  Difference

2. TranSight transforms the data into a TranSight-ready format and the window for the concept you chose appears (the three windows are cosmetically and functionally identical).
3. Click the tabs to switch between the Road and Transit data.
4. Use the drop-down menus to see the data broken down by specific dimensions (such as time periods). Select **Total** to view the sum of VMTs, VHTs, and trips for that particular dimension.
5. To copy data from any of the tables to the Clipboard (so that you can paste it into another program, such as a spreadsheet), select the cells you wish to copy, right-click on the table, and choose **Copy** or **Copy with Names** from the menu that appears. Copy with Names copies both the cells and the names of their rows and columns.
6. To see more or fewer decimal digits of detail, right-click and select **Show Detailed** from the menu that appears. The default is three decimal places; choosing this option once will show six places, choosing it twice will show nine places, choosing it three times will show zero places, and choosing it four times will show three places again.
7. If you wish to see any of the tables as a chart, right-click and select **Display as Chart** from the menu that appears. A line chart will appear, showing the change over time in the number of VMT, VHT, or VTT. The x-axis corresponds to the columns of the table (years), and each line shown corresponds to a row (origin region). The y-axis represents the number of VMT, VHT, or VTT.

![Line Chart Example](image)

If AutoScale is checked, choosing a different mode of travel, road type, or time of day will automatically scale the new graph to fit. If AutoScale is not checked, the graph does not automatically scale; this provides a better view of the differences between the travel patterns in one mode of travel, road type, or time of day.

To see a pie chart instead, select **Pie Chart** from the **Display As** combo box. Each piece of the pie chart represents an origin region; its slice of the pie represents its share of total VMT, VHT, or VTT. Use the slider to display the shares for a different year; select **Line Chart** from the **Display As** combo box to return to the line chart.

Right-click on a desired chart and select **Copy** to copy an image of the chart to the Clipboard; you can paste it into a graphics program such as Paint or Photoshop. Right-click and select **Display as Table** to return to the default table view.

Please note that you may have to enlarge your TranSight simulation window to see the chart well, particularly if it is a pie chart. Do this by dragging the edges of the window outward with your mouse until it is the size you want.

8. Click the **Close** button to close the window.

**Computed Difference**

The Computed Difference is the calculated difference in VMT, VHT, and VTT between the Adjusted Simulation and the Baseline Simulation. Viewing this information is easy from the Travel Data Tab.

**Region-to-Region Spread**

Travel-demand models are limited in terms of how they show data. TranSight enables you to view not only the VMT and VHT data for each region, but also to see vehicle miles, hours, and
trips within each region and between each pair of regions. TranSight breaks the information
down in terms of trips to and from each region in the model (including trips within regions), and
displays the percent of VMT and VHT for each. Access the Region-to-Region Spread from the
Adjusted and Baseline Simulation windows and the Computed Difference window.

1. Click the Region-to-Region... button, located at the upper right of the Adjusted or Baseline Simulation, or Differences, windows. The Region-to-Region Spread window opens.

2. Click the different tabs to view the data for VMTs, VHTs, and trips. In each table, the origin region is the row and the destination region is the column.
3. To examine breakdowns of the data across different dimensions (e.g., autos vs. trucks), select different options from the drop-down menus.
4. To see the sum of travel data across a particular dimension, choose Total in the drop-down menu. This number is a sum of all the data, which gives a combined view of the information (e.g., autos and trucks together).
5. To copy data from any of the tables to the Clipboard (so that you can paste it into another program, such as a spreadsheet), select the cells you wish to copy, right-click on the table, and choose Copy or Copy with Names from the menu that appears. Copy with Names copies both the cells and the names of their rows and columns.
6. To see more or fewer decimal digits of detail, right-click and select Show Detailed from the menu that appears. The default is three decimal places; choosing this option once will
show six places, choosing it twice will show nine places, choosing it three times will show zero places, and choosing it four times will show three places again.

7. You can view the Region-to-Region tables as charts; this works the same way as described under Baseline and Adjusted Simulations, above, only with destination regions rather than years as the x-axis of the line chart and the slider on the pie chart controlling destination regions rather than years.

8. Click the Close button to return to the Adjusted or Baseline Simulation window.

Simulation Parameters

For a number of costs affected by transportation projects, TranSight includes data derived from national sources. This data includes:

- Emissions Rates and Costs
- Value of Time
- Fuel Efficiency
- Accident Rates and Costs
- Fuel and Non-Fuel Operating Costs.

Usually you won’t need to change these values, but, if you have more accurate local data, TranSight allows you the option to enter it.

To view and edit this data click the View / Edit button next to Advanced Parameters, which opens the main Simulation Parameters window.
TranSight groups the available parameters under the following three tabs:

- **General** – Emissions (Cost/Gram), Value of Time (Value of Leisure Time), and Government Funding (Amenity Loss from Use of Non-dedicated Government Funding as Wage-equivalent Reduction in Government Services).
- **Road** – Emissions (Grams/Mile), Fuel Efficiency (Average MPG), Safety (Accidents/Million VMT & Accident Value in $US), Operating Costs (Fuel in $/Gallon & Non-fuel in $/Mile), and Vehicle Occupancy (Passengers/Vehicle)
- **Transit** – Emissions (Grams/Mile), Safety (Accidents/Million VMT & Accident Value in $US), and Vehicle Occupancy (Passengers/Vehicle)

To view or edit these values, select the appropriate tab and click the button.

**The “Region” Combo Boxes**

Most of the selections in the various Simulation Parameters windows feature a “Region” combo box. In your customized model, this combo box should display the regions specific to your model, along with the “All” option. There are two important things to know about these options:

- The Region combo box is global. This means that if you select “Suburbs” on the Emissions panel of the Road tab, and then switch to the Fuel Efficiency panel, “Suburbs” remains selected.
- The “All” setting is designed to allow you to set all regions to the same value. It is **not** an average or sum of the values in all of the regions. If the value for a particular cell is different in the two areas, the cell displays “N/A” when you select “All” from the region combo box.
The General Tab

The General Simulation Options window allows you to view or edit three sets of parameters. Click the icon on the left to select the following panels:

- **Emissions** – Cost/gram for five pollutants (Volatile Organic Compounds, Nitrogen Oxides, Carbon Monoxide, Sulfur Oxides, and Particulate Matter) for each model region.
- **Value of Time** – Value of Leisure Time ($US) for each model region.
- **Government Funding** – Percent amenity loss due to the reduction in other government services needed to fund the transportation project. For example, if you reduced non-dedicated funding by $40 million to pay for a project, a 75% parameter would imply a loss of $30 million in valued government services.
The Road Tab

The Road Simulation Parameters window allows you to view or edit five sets of parameters. Click the icon on the left to select the following panels:

- **Emissions** – Grams per mile @ 0-80 mph for five pollutants (Volatile Organic Compounds, Nitrogen Oxides, Carbon Monoxide, Sulfur Oxides, and Particulate Matter) by region and by vehicle mode (Auto or Truck).
- **Fuel Efficiency** – Average mpg @ 0-80 mph by region and by vehicle mode (Auto or Truck).
- **Safety** – Accidents per million VMT and Accident value in $US, both by region and by time of day (AM peak, PM peak, AM non-peak, PM non-peak) categorized by Fatalities, Injuries, and PDO (Property Damage Only).
- **Operating Costs** – Fuel costs in $ per gallon by region and by vehicle mode (Auto or Truck) categorized by Pre-tax Fuel Price, Federal Excise Tax, State Excise Tax; and Total Non-fuel costs in $ per mile (Non-fuel costs represent mileage-related vehicle maintenance).
- **Occupancy** – Vehicle Occupancy in all regions categorized by vehicle mode (Auto or Truck).
The Transit Tab

The Transit Simulation Parameters window allows you to view or edit three sets of parameters. Click the icon on the left to select the following panels:

- **Emissions** – Emission Amounts in Grams per mile by region and for three vehicle modes (Passenger Train, Light Rail, and Bus) categorized by five pollutants (Volatile Organic Compounds, Nitrogen Oxides, Carbon Monoxide, Sulfur Oxides, and Particulate Matter).
- **Safety** – Accidents per million VMT and Accident value in $US, both by region and for three vehicle modes (Passenger Train, Light Rail, and Bus) categorized by Fatalities, Injuries, and PDO (Property Damage Only).
- **Occupancy** – Vehicle Occupancy in all regions categorized by Passenger Train, Light Rail, and Bus.

**Saving and Restoring Parameters**

Saving the changes that you make in the various Simulation Parameters windows is not strictly required; when you change the values in these windows, TranSight uses these values until you change them again. However, sometimes you may want to compare results based on two or more sets of values. To make this process easy, TranSight lets you save the Simulation
Parameters to a file for later recall. The original settings for each tab are stored in the “Default” file. Each tab uses a different filename extension:

- General: “.spf”
- Road: “.rpf”
- Transit: “.tpf”

To save the changes you make to the values in the various Simulation Parameters windows, use the **Saved Settings** section of the main Simulation Parameters window.

After you make changes to the Simulation Parameters, enter a new filename in the Saved Settings text field. **Important: Do not save your changes to the “Default” file. The Default file allows you to reset the Simulation Parameters to their original values.**

Once you’ve entered a new filename, simply click the **Save** button. TranSight saves your new settings in an easily retrieved file.

If you have several datasets that you’ve saved, you can select one using the following steps:

1. Click the Browse (…) button at the right of the file path field. TranSight opens an **Open** window.
2. Navigate to the desired parameter file and double-click it. TranSight enters the file into the Saved Settings file path field.
3. Click the **Load** button. TranSight automatically loads the saved parameter values into the Simulation Parameter tables.

To restore the values to their original settings, select the file named “Default” in step two above.

**The Add To Inputs List Button**

When you’re ready to add the Policy Variables created by the Travel Demand Study dialogue and return to the Insert ribbon, click the **Add To Inputs List >>>** button. You should now notice that the policy variables list has been filled with the following groups of policy variables:

- **Emissions**: The change in pollution-related health costs (summed across the five major motor-vehicle pollutants) due to the change in VMTs caused by the transportation
project. The Amounts tab shows the change in grams of emissions (for each of the five pollutants) due to the change in VMTs.

- **Leisure Time**: The value of leisure time either saved or lost due to the change in VHTs caused by the transportation project. A negative number on this table represents time (and cost) savings for that region.

- **Safety Costs**: The change in accident-related costs (including health and the value of lost life) due to the change in VMTs caused by the transportation project.

- **Operating Costs**: The change in fuel costs and non-fuel costs due to the change in VMTs caused by the transportation project (non-fuel costs include such factors as vehicle maintenance).

Note that no changes to either policy variables or values may be made here, except to make them inactive or active by unchecking/checking the box . Only active variables will be included when the simulation is run. This option makes it easy to run multiple simulations with different combinations of variables included. Doing so isolates the direct impact of individual variables.
Cost Matrices

You can also view/edit the changes to the Transportation cost matrices by clicking on the Effective Distance menu in the Transportation Group on the Ribbon. Next choose to edit the values As Transportation Cost Matrix. This will take you to the Transportation Costs Editor.

There are three cost matrices you can view/edit by choosing the appropriate radio button below Transportation Matrices:

- **Commuter Costs** - describes the amount of commuter time savings within or between modeled regions over the average workday.
• **Accessibility Costs** - describes access to more diverse consumer goods and services by households, as well as access to a broader array of intermediate inputs by employers.

• **Transportation Costs** - describes the amount of cost savings in transporting goods and services due to an increase in transportation efficiency.

These matrices are used to calculate the amount of cost savings induced by improvements in the transportation network. The numbers in the table represent the percentage of savings across the transportation system for specific pairs of regions (including within each region), relative to the baseline:

- 1 = no change from the baseline
- Below 1 = cost savings relative to the baseline
- Above 1 = cost increases relative to the baseline (e.g., during a construction period)

For example, 0.99 represents a 1% cost savings across the transportation system for that region or pair of regions.

You can also change the view to better allow you to see or edit the changes made.

Once you are done making any changes to the matrices, you can click the button. If you do not wish to save any changes you have made or were simply viewing the results of the Travel Demand Study, click the button instead.
Additional Highway Inputs

After you have run the Travel Demand study, you may wish to add additional policy variables to further detail the changes created by the project. Back on the Insert Ribbon under the Highways button of the Transportation group there are three additional categories of data inputs:

- **Design and Construction**
  A change in road or transit construction activity can enter the model as Demand or Sales/Employment.

- **Operation and Maintenance**
  A change in construction activity reflecting road or transit operation and maintenance spending can enter the model either as Demand or Sales/Employment.

- **Government Funding**
  Funding options for transportation-related projects typically involve a combination of several sources, including federal, state, and local governments, as well as specific consumer and business taxes/fees.

For this Transportation Scenario we will include some Construction to supplement the Travel Demand Study inputs we created earlier. Click on the Highways button, and select Design and Construction.
The Selector and Editor grids appear. Give the scenario a meaningful name, such as “Highway Construction”. Read the scenario description for helpful information and hints applicable to the selection.

In the Selector grid, choose from applicable groups, in this case, Construction Demand, Construction Sales/Employment, Professional and Technical Services Demand, or Professional and Technical Sales/Employment. A description of each appears in the information box. Select the desired Category, Detail, Region, and Units and then click the Insert Into Editor button.

For this sample scenario, choose Construction Sales, Firm Sales (amount), Suburban, and 2005 Fixed National $ (M). This is a scenario in which construction sales for particular firms in suburban counties change by a certain amount in millions of dollars. Read the information box for additional notes regarding the policy variable. When ready, click the Insert Into Editor button.
Using the Editor grid, values can be entered for each year. To assist in the entry process, the Spreader and Calculator tools may be helpful. The Spreader allows you to spread values across selected policy variables and the Calculator allows you to fill a selected range with a specific number in addition to calculating various types of growth and decline. Here’s how to access the calculator:

1. Select a year or set of years in the editor grid. The Calculator function now becomes an available tool. Click the Calculator. The Row Calculation window opens.

2. Select the function you wish to use by clicking on the appropriate tab.
3. Enter the values for the given calculation type.
4. Click on OK, and the numbers in the selected cells change accordingly.

The Row Calculation tabs are defined below.

- **Fill Range**—Enters the same number in each of the selected cells. For example, if you enter 50, then the number 50 would appear in each cell in your selection.
- **% Change**—Changes the selected cells by the percentage that you enter.
- **± Value**—Changes the selected cells by the number you indicate. For example, if you entered 10, the program adds 10 to the number in each cell.
- **Linear (Interpolate Rows)**—Select this option to have the system work with your beginning and endpoint values for a particular row. For example, suppose that for a particular TranSight variable you have target values for every fifth year. Use this option to assign yearly values linearly interpolated between the five-year targets.
- **Exponential (Interpolate Rows)**—Select this option to have the system work with your beginning and endpoint values for a particular row. Unlike linear interpolation, the function determines a geometrical growth rate between the endpoints, and distributes the change between those two points geometrically.
- **Annualize**—Calculates the annualized payments required to pay the amount borrowed at a given interest rate for a fixed number of years. To use this option you need to enter the number of years over which the payments are to be made (or choose “Selected Years” if
the highlighted range reflects this number), the value being financed, and the interest rate. The rate is entered as a percent.

For this scenario, we simply want to fill the value 10 from the Start Year of 2010 to the End Year of 2015. Make these changes and click OK.

10 should be filled in the Editor Grid representing a 10 million dollar increase in Construction Sales in suburban regions for 2010 to 2015.

If this is the only desired policy variable change, click the Add to Inputs List button at the bottom of the screen. The Policy Variable Inputs view now displays the Construction Sales policy variable that was just entered and the Travel Demand Scenario added earlier.
Note that no changes to either policy variables or values may be made here, except to make them inactive or active by unchecking/checking the box. Only active variables will be included when the simulation is run. To go back and edit policy variables or their values, click on the edit button, which will take you back to the Selector/Editor grid.

It is a good idea to give the forecast a meaningful name by changing the text in the text box labeled Forecast Name. This will make it easier to identify this simulation while you are in the Workbook view. For this example, we will use “Highway Simulation 1”.

You may also determine the appropriate baseline which the simulation will be compared to (the Standard Regional Control is the default and only option unless the user has created other alternatives). Also, determine the length of the forecast to be run (2050 is the default).

When ready to run the simulation, click the Run Now button. A status bar displays stating the elapsed time and estimated time remaining. Models with a small number of regions will run in only a few seconds on a fairly fast computer.
When the forecast has completed running, the Results tab appears.

It is helpful at this time to maximize the application display so it fills your monitor screen, if you have not already done so.

The default view shows Summary concepts displayed as both a table and a line chart. The Display group on the far left of the ribbon also provides a map view for multi-region models. One, two, or all three views may be activated at a time.

- The Display group also has buttons for adjusting decimal precision, chart type, and allows pivoting of the data to rearrange the layout of the grid.
• The Data group provides buttons for viewing the data as levels, percent change, or differences. It also allows the Years, Regions, and Forecasts viewed to be adjusted.

• The Results Tables group presents several categories of tables to view. Under Economic one can find all of the model’s economic variables in organized tables. Under Demographic one can find all of the model’s demographic concepts in organized tables. Custom Tables allows you to edit and create tables according to your own needs. It is also possible to view tables related to the Model Linkages diagram, DevSight, and several Extras, such as Analytical Graphs.

• The Export group allows you to save a table to another format for easy import into other applications, such as a spreadsheet.

When done viewing the simulation results, close the Results tab window by clicking on lower X in the upper right hand corner.

Then close the Insert tab window by clicking again on the lower X in the upper right hand corner. You will be prompted to save the forecast to the workbook. Click Yes.
Then you will be prompted to give the workbook a name, such as Highway Study. Then click the Save button.

Your Workbook view will now display the Highway Study simulation labeled **Highway Simulation 1**.

To reexamine the policy variable inputs, simply double click on the **Policy Change** box of the flow chart. To reexamine the simulation results, double click on **Highway Simulation 1** box.

Likewise, the **Standard Regional Control** and **Standard National Control** data may be viewed by double clicking on those respective boxes.
To close the application, click on the top X in the upper right hand corner.

To start over, click the TranSight symbol in the upper left hand corner and select New. Then decide whether you want to save the simulation before starting over.
Modeling an Economic Scenario

To model an Economic Scenario, such as a plant shutdown, click on the Scenarios button, and select Employment & Sales.

The Selector and Editor grids appear. Give the scenario a meaningful name, such as “XYZ Plant Shutdown.” Read the scenario description for helpful information and hints applicable to the selection.

In the Selector grid, choose from applicable groups, in this case, Firm Behavior or Industry Behavior. A description of each appears in the information box. If you know that XYZ is a manufacturing company, but you are not sure whether or how much it supplies the local region, choose Firm Behavior.
In the Category box, choose Firm Employment, since for this simulation we will assume we know the number of direct jobs being lost. This selects the specific policy variable to be changed. Read the information box for additional notes regarding the policy variable. In the Detail box, select the industry that XYZ is classified as. In this example, assume it is Machinery manufacturing. In the Region box, select the region where the plant is located, which is Urban Counties. In the Units box, select the appropriate units matching your inputs, in this case Units (number of individual jobs).

When ready, click the Insert Into Editor button. The Editor grid now displays the policy variable selected. Enter job losses, with a negative value, by year. Since the value will be constant throughout the forecast period to reflect permanent job losses, the calculator may be used to automatically fill in the values for all years.
To do this, highlight the range of cells, in this case 2010-2060, and click on the Calculator button on the Tools group of the ribbon. Enter the value to be filled in each year, in this case -675 (for a job loss of 675 employees). Then click OK.

The Editor grid is now filled with a time series of the value entered.

If this is the only desired policy variable change (perhaps because it is the only input information available), click the [Add to Inputs List] button at the bottom of the screen.

The Policy Variable Inputs view now displays, listing the policy variable category just created. Click the expand button (+) to see the details.
In this example, only one policy variable is listed. If multiple variables had been selected, then would also be listed here. Note that no changes to either policy variables or values may be made here, except to make them inactive or active by unchecking/checking the box. Only active variables will be included when the simulation is run. To go back and edit policy variables or their values, click on the edit button, which will take you back to the Selector/Editor grid.

It is a good idea to give the forecast a meaningful name by changing the text in the text box labeled Forecast Name. This will make it easier to identify this simulation while you are in the Workbook view. For this example, we will use “XYZ Plant Shutdown”.

You can determine the appropriate baseline which the simulation will be compared to (the Standard Regional Control is the default and only option unless the user has created other alternatives). Also, determine the length of the forecast to be run (2060 is the default).

When ready to run the simulation, click the button. A status bar displays stating the elapsed time and estimated time remaining. Models with a small number of regions will run in only a few seconds on a fairly fast computer.
When the forecast has completed running, the Results tab appears.

It is helpful at this time to maximize the application display so it fills your monitor screen, if you have not already done so.

As was described in the previous simulation, the default view shows Summary concepts displayed as both a table and a line chart. The Display group on the far left of the ribbon also provides a map view for multi-region models. One, two, or all three views may be activated at a time. For further details on what the elements of these groups do, please review the previous section **Modeling a Transportation Simulation**.

When done viewing the simulation results, close the Results tab window by clicking on lower X in the upper right hand corner.
Then close the Insert tab window by clicking again on the lower X in the upper right hand corner. You will be prompted to save the forecast to the workbook. Click Yes.

Then you will be prompted to give the workbook a name, such as XYZ Plant Shutdown. Then click the Save button.
Your Workbook view will now display the XYZ Plant Shutdown simulation.

To reexamine the policy variable inputs, simply double click on the Policy Change box of the flow chart. To reexamine the simulation results, double click on the XYZ Plant Shutdown box.

Likewise, the Standard Regional Control and Standard National Control data may be viewed by double clicking on those respective boxes.

To close the application, click on the top X in the upper right hand corner.
Other Features and Usage Tips

Cumulating Policy Variables and Understanding Results

Introducing one policy variable at a time into a simulation facilitates understanding how the specific choice and magnitude of the input affects the net results. This may be especially useful when there are different or offsetting components that make up the analysis.

This process is best illustrated with a simple example. Say a state or local government is considering increasing its general level of services and plans to finance this with an increase in personal taxes. Running these two policy variables together will generate the net results, but this will not necessarily give the analyst a feel for the magnitude of the positive impact of the new spending versus the negative impact of the new taxes. By running the simulation in a cumulative fashion, the individual effects as well as the net effects can be understood.

Selecting and Activating Variables

**Step 1:** Start a new Regional Simulation. Click the Topics button on the Insert tab ribbon, and select Government Spending. In the Selector grid, click on Government Spending (amount), choose the Urban Counties region. Then choose the proper units, in this case 2012 Chained National $ (M). Click Insert into Editor, and enter a value of 100 for each year for 10 years, beginning in 2012 ($100 million per year from 2012-2020).
Step 2: To add the second policy variable, click the Topics button on the Insert tab ribbon and select Consumer Taxes. Choose the appropriate units (2012 Fixed National $ (M)), Insert into Editor, and enter a value of 100 for the same years (2012-2020). Then Add to Inputs List.

Step 3: The Policy Variable Inputs View shows both policy variables. For the first simulation, we want to run one alone, so deactivate the Personal Taxes policy variable by unchecking the active box. Name the forecast, in this case, $100M Government Spending Alone, and set the run to year to 2020 since we are only interested in a 10 year time horizon.
Then click the **Run Now** button. The results show the effect of the additional government spending only, which leads to positive employment changes.

**Step 4:** Close and save this forecast to a new workbook. The Workbook view now shows the saved simulation.
To copy the policy variables already selected to a new simulation, click on the Policy Change box, and then go to the Quick Access Tool Bar in the upper left hand corner of the application and click on the paste button 📅. Give the simulation a meaningful name, in this case, $100M Government Spending with Tax Increase, and click OK. A new forecast branch is now visible. The new forecast name is currently ghosted because the forecast has not yet been run.

**Step 5:** Double click on the new Policy Change box in order to access the Policy Variable Inputs window. Since an exact copy of the policy changes from the first simulation was made, the Additional $100M Personal Taxes policy variable is still inactive. To active this variable, click on the check box. Change the run to year to 2020 (if it is not already the year displayed) and click Run Now.
The results now displayed are net for both the additional $100M of new government spending, and the additional $100M of new personal taxes.

**Step 6:** You are now ready to analyze the results. To see the effect of just the increase in personal taxes, click on the Forecast button on the Data group of the Results tab ribbon, and select the Government Spending Alone forecast for comparison. Click OK.
The Results now reflect just the additional taxes, which leads to a loss of jobs.

By going through the policy variable selection process just once, you have been able to generate results for three different simulations: government spending alone, government spending combined with additional personal taxes, and personal taxes alone. Each policy variable generates a change in many of the endogenous variables of the model and it is important to be able to understand how the final results of a simulation are influenced by the specific policy variables that are used. By seeing the effects of each policy variable change, you will be better able to explain the final result when all of the variables are combined.

**Using Analytical Graphs to Understand Results**

Analytical Graphs are organized to illustrate the main determinants of key variables of the model. By stepping through the graphs, you can quickly see the percent change in a key variable as well as that variable’s main determinants, allowing you to isolate the primary cause and effects of the simulation changes.
Looking at the $100M Government Spending with Tax Increase simulation (compared to the Standard Regional Control), the State and Local Government Spending Determinants chart illustrates the total percent change to State and Local Government Spending, which is a combination of both the direct $100M input as well as the indirect effect of a slightly higher population and economy (measured in Total GDP).

The effect on employment can be explained by viewing the Total Employment Components chart. A change in government employment leads the way, which is logical since the direct input was additional government spending, most of which, on average, is used to support employment. The change in Private Non-Farm Employment is the indirect effect of the additional government spending.
To better understand the change in Private Non-Farm Employment, you can look at the Private Non-Farm Employment Components by Demand Source chart, which shows the percent change in employment by type of demand. Consumption and Intermediate Demand are typically the largest components of demand, so these changes track the most closely to the overall change in Private Non-Farm Employment. The additional government spending led to an increase in consumption primarily due to the spending of compensation earned by the new government employees. The intermediate demand increased due to additional demand by consumers as well as direct spending of the government on supplies, etc.
Looking at the $100M Tax Increase Alone simulation (compared to the Standard Regional Control), the Real Disposable Personal Income per Capita Determinants chart illustrates the total percent change to Real Disposable Income, as well as the percent change in Real Disposable Income per Capita, which is also affected by the percent change in Population. Increasing personal taxes leads to additional outward flow of economic migrants (due to the increased cost of living in the area), which lowers the overall population, mitigating the percent change in Real Disposable Income per Capita compared to the percent change in Real Disposable Income.
The Consumption Determinants chart shows the percent change in Consumption, as well as the primary causes for this, Population (by age cohort) and Real Disposable Income per Capita. A smaller population and less income per person result in less consumption.
The Final Demand Components chart shows the percent change in major components of GDP. The overall negative effect on the economy (driven by less consumption) leads to less fixed investment over time, due to a smaller optimal capital stock.
The effect on employment can be explained by viewing the Total Employment Components chart. Private Non-Farm Employment shows the largest decrease in terms of percent change.
The overall loss of jobs is primarily explained by the decrease in demand for Consumption, Investment, and Intermediate goods.
Moving the Tables to a Spreadsheet

To make more complex adjustments to several cells, move the data to a spreadsheet application.

1. Open your spreadsheet application (we use Microsoft Excel for demonstration purposes).
2. Switch to TranSight.
3. Select the cells you want to work with.

4. Press Ctrl-C (or right-click and select **Copy**) to copy the cells. To also copy the row and column headers press Ctrl-N (or right-click and select **Copy with Names**)
5. Switch to Excel.

Press Ctrl-V (or right-click and select Paste) to paste the cells into Excel.

6. Modify the cells as needed.

7. Select the cells in Excel.
8. Press Ctrl-C to copy the cells.
9. Switch to TranSight.
10. Place the cursor in the topmost or leftmost of the cells you moved to Excel.

11. Press Ctrl-V or right-click and select Paste to paste the cells back into TranSight.
Getting Additional Help

Help is available in the following forms:

- REMI Technical Support

Contacting REMI Technical Support

You may contact REMI Technical Support at 413-549-1169. Be sure to be sitting near your computer so a REMI support person can help you with your problem.

REMI’s Web Site

REMI’s Web site, www.remi.com, contains a Frequently Asked Questions (FAQ) page, a glossary of terms, and extensive product documentation. There is also a listing of upcoming REMI conferences. You can also contact a member of the REMI staff anytime by sending an e-mail to info@remi.com.